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What is Macromedia Flash?
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”Macromedia Flash, a popular authoring software developed by Macromedia, is used to create 
-based animation programs with full-screen navigation interfaces, graphic illustrations, and simple interactivity in a resizable file format that is small enough to stream across a normal modem connection.  The software is ubiquitous on the Web, both because of its speed (vector-based animations, which can adapt to different display sizes and resolutions, play as they download) and for the smooth way it renders graphics. Flash files, unlike animated GIF
 and JPEG
, are compact, efficient, and designed for optimised delivery. 

"Known as a do-it-yourself animation package, Flash 4 gives Web designers the ability to import artwork using whatever bitmap or illustration tool they prefer, and to create animation and special effects, and add sound and interactivity. The content is then saved as file with a .SWF file name extension. 

"Web users with Intel Pentium or Power Macintosh processors can download Flash Player to view Flash content, which performs across multiple browsers and platforms. Flash is lauded for being one of the Web's most accessible plug-in. According to an independent study cited by Macromedia, 89.9 percent of Web users already have Flash Player installed.”

Taken from www.whatis.com
Basics

The Flash environment although complex is deceptively simple.  It’s possible to get started straight away.

In this handout you will discover how to:

· See how easy you can draw and make a quick animation

· Become familiar with the Flash environment

· Learn the common file types associated with Flash

Jump Right in

It’s actually possible to learn to make flash animation in a matter of seconds!  Although this task won’t cover all there is to learn, it should demonstrate how quickly you could use Flash and how different it is to use compared to Notepad or Dreamweaver for HTML and JavaScript when creating Web content.
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Fig 1.1 The Macromedia environment
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Exercise 1: Make an animation in 5 minutes!

Just to demonstrate that using Flash can be easier than it would appear we are going to make a simple animation, follow these steps below:

1) Open Flash 8 and make sure that the interface looks similar to the one above.  If it doesn’t or you can’t find Flash on your PC ask for assistance from the member of staff present.

2) Press the letter R to turn your cursor into a rectangle tool.  (You should also notice that the rectangle tool becomes active in the tool panel on the left hand side of the screen.)

3) On the left hand side of the page draw a medium sized rectangle.  This will be the object that we intend to animate.

4) Make sure that the timeline is visible as mentioned in Fig 1.1.  If you cannot see it select it from the Window menu at the top of the screen.

5) In the timeline click the cell directly under frame 20, then press F7 to insert a new key frame

6) Now press the letter O (still at frame 20 in the timeline) and draw a medium sized oval on the right hand side of the page.

7) Return to frame 1 by clicking the dot under frame 1 in the timeline.

8) Check that the properties box is visible at the bottom of the screen, as in Fig 1.1.  You should see the properties for frame 1 as that is the last thing you clicked during this exercise?

9) Finally in the properties pane at the bottom select the shape option from the tween drop down box.

10) To view your animation simply press enter.

Congratulations you have successfully created your first Flash Movie!

Some useful terminology

Frame:

A frame is an event in time, it can either have the same properties as the frame before or another instance on the page can start at this point.  An event or new item occurs in a single frame.  It is by running these frames one after another that we get a frame rate (fps or frames per second) and how we create a movie.

Tween:

Flash can create two types of tweened animation, motion tweening and shape tweening. 
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	In motion tweening, you define properties such as position, size, and rotation for an image, group, or text block at one point in time, and then you change those properties at another point in time. You can also apply a motion tween along a path.
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	In shape tweening, you draw a shape at one point in time, and then you change that shape or draw another shape at another point in time. Flash interpolates the values or shapes for the frames in between, creating the animation.


Tweened animation is an effective way to create movement and changes over time while minimizing file size. In tweened animation, Flash stores only the values for the changes between frames. 

In the box below write a definition of the timeline:
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Fig 1.2: The Tool Panel

The tools panel is the panel with which you will likely be most familiar.  Any time you create or edit anything on the page you’ll need to select a tool from the Tools panel.

Some of the most important tools on the tools panel are

1) The Black Arrow selection tool

2) Draw a straight line

3) The lasso tool allows you to select and area of an image/movie and separate it from the original drawing

4) The pen tool, allows you to draw irregular shapes

5) Insert text

6) The pencil tool, allows you to draw any lines like a pencil

7) The brush tool, allows you to draws/fill areas with colour on the screen, like a very thick pencil tool

8) Ink bottle tool, used to effect change on a line that has already been drawn

9) The eraser used to remove any unsightly mistakes

10) Depending what it is you are drawing will depend on how this section is displayed.  However usually you can set the colour of the item that you are about to draw by using the colour palette located here at the bottom of the tolls menu.

Exercise 2: Tween Position, Scale, Rotation and Colour

In exercise 1 we saw how to make an item move and change colour.  In this exercise we are going to take what you have already learnt and combine this with new features that include changing the shape and rotation of a new item.

1) In a new file, use the text tool (refer to fig 1.2) to create a text block that contains your name.  Don’t worry about the exact size, just make the text big enough so that it is clear on the page.

2) Using the arrow tool (black) select the block of text, not the text itself.  Then right-mouse click and left-click Convert to Symbol. And name the symbol yourname.  Make sure that you select movie clip behaviour and click OK.

3) Now click the timeline on frame 30 and insert a keyframe (right click, insert a keyframe.

4) Click on the black dot in the timeline at frame 1 (the red current frame marker will move to the current frame), so the first keyframe is selected and then re-position your name in the bottom left hand corner.  This will be its initial position.

5) While the first keyframe is selected, pick Motion from the tween drop down menu in the properties panel.

6) Now click on the keyframe in page 30 so that you can edit the end position.  Select the transform tool as shown below, this should now outline your text in a black frame.
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7) Use the free transform tool to make the text large enough to fill the width of your page.


[image: image6.png]& ||t e %) T [eows oo




8) (As shown above), click on the red current frame indicator and move it forwards and backwards along the timeline, you should notice that your text now gets larger and smaller depending on the position of the current slide indicator.

9) Click on the keyframe at frame 30: this time you have to click the little grey box or cell around the black dot. Then click on the text box containing your text, (again do not highlight the text itself).  Select Tint from the colour styles drop down list (shown below), pick a bright colour and set the percentage to 100%.
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10) Go back to keyframe 1 and rotate your name so it is upside down, now move the red current slide indicator backwards and forwards along the timeline.  Notice that Flash has figured out to perform the animation from one keyframe to the next.

What have we learned so far?

During this first Macromedia Flash handout you have learnt many things about developing Flash movies.

In summary you have learned about the Flash environment and the tools available to you when working with Flash.  In addition you have completed two movies where you have seen how Flash can automatically manipulate the height, colour, rotation and width of text and objects drawn on the screen over a set period of time.  In the next handout we will look at working with multiple objects, layers, motion guides and see if we can use buttons to create a working website in Macromedia Flash.

Macromedia Flash 8 for Beginners (2)

During the first handout in this series you learnt how to make a simple flash movie

Using layers in your animation

How layers work

In Flash multiple layers really means multiple timelines.  The images/text or objects contained in layers are stacked above and below each other but their primary purpose is to provide you with separate timelines in which you can control animations independently.

Exercise 3: Use two layers to animate two circles

1) In a new file, draw a circle, on the left hand side of the page. Select it, by clicking on the Black Arrow (selection) tool (see 1. on page 4) at the top left of the Toolbox and dragging with the mouse to draw a box round the shape.  Now press F8 and convert it to a symbol, leave the default behaviour as a movie clip and click ok

2) Double click at the left hand side of the timeline to name the layer, change the name of the layer to circle, as shown in the diagram below.
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3) Click frame 30 on the circle layer (ensure that the current frame indicator has moved there), and right click, insert keyframe.

4) Ensuring that you are still working at frame 30 move the instance of the circle to the right hand side of the screen.

5) As in exercise 1 select frame 1 on the circle layer and in the properties panel in the tween drop down menu select motion.  (To test the tween slide the current frame indicator backwards and forwards and the circle should move from left to right accordingly).

6) Let’s create a new layer.  Click the add layer button as shown in the diagram below:
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7) Immediately layer 2 will appear above layer one. Rename the new layer to Slow.
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8) From this point forward you will need to remain conscious of the layer in which you are working (that is where you are).  You can only be in one layer at any one time.

On the next page, we are going to copy an instance of the circle from the circle layer to the slow layer.

9) Click an instance of the circle to select it and copy it the clipboard (ctrl+c).  Because you click an item that existed in the circle layer you made that layer active.  Before you paste the circle make sure you make the slow layer active by clicking the word slow and then paste.  Position the new instance of the circle to the left hand side of the page but not directly on top of the other circle in the circle layer.
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10) To keep the two circles visibly different, tint the newly pasted circle (exercise 2)

11) In frame 30 of the Slow layer select insert keyframe.  Move the new instance of the circle over to the right, not as far as the end point of the original circle. Then in frame 1 of the slow layer insert a motion tween.
12) Now select the circle at frame 1 of the slow layer and make it overlap the other circle.  Notice that the circle from the slow layer is on top of the circle from the circle layer.

13)  With Frame 1 of the Slow layer selected, set a Motion Tween.

14)  Press Enter to test your movie.

Question:  Why do you think the circle from the slow layer overlaps the circle from the circle layer and how can we make the circle from the circle layer overlap the circle from the slow layer?


Motion Guides

Now if we want to animate objects other than in a straight line we can use a motion guide.  That means you can draw an S-shaped line and then set an object to follow that line.  For motion guides to work we have to work with two layers, the motion guide layer and the guide layer.

Exercise 4: Create a bouncing ball

1) Create a new file and draw a ball at the bottom of the left hand side.  Save the file to your student area on the server or your floppy disk, call it ex4.
2) Select the Arrow tool at the top left of the Toolbox.  This is the selection tool.  Click and drag to draw a box round the whole of the ball.  This will select both its fill and its outer edge.  From the Modify menu, select Group.

3) Double click on the Layer name and rename it Ball

4)  Insert a keyframe at Frame 40 on the Ball layer.

5)  Click on Frame 1 and insert a motion tween.

6)  From the Insert menu, choose >Timeline >Motion Guide.  A new layer will appear above the Ball layer:
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7) The Guide Layer will be selected.  Use the pencil tool with the Smooth option to draw an S-shaped path for a bouncing ball.  (Click on the pencil tool, then on the Pencil Mode button under Options below the Toolbox and select Smooth).


8) Click on the Ball layer. To see the centre of the ball, click on the Free Transform tool and then on the ball.  A white circle will mark its centre.  Put the ball at the beginning of the line in Frame 1, and at the end of the line in the Keyframe 40.  Ensure that the ball’s centre is directly over the end of the path.  
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9) Move the red current slide selector on the timeline backwards and forwards and hey presto, your ball will now move according to the path.  If you want to see your movie, click the Control menu and select Test Movie.

What have we learnt so far?

In this handout you have learnt many ways in which Flash can be used and how it works as a package.  You have learnt how to work with multiple layers and animations, and how to use motion guides.  In the next exercise we are going to use your movie to make an introduction screen for a web page.

Exercise 5: Publishing your movies

Still working with the movie that you created in exercise 4 we are now going to look at how we can include your flash movie as part of a web site.

1) Click on the file menu and select Publish Settings, in this window select the HTML tag and ensure that your settings match the ones shown in the diagram below;
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2) If the settings are correct, click Publish.

3) Close Flash 8 and click ‘Yes’ to save changes, then go to where you saved your work in step 1.  There should now be two more files that have the same name as your original file, one with an htm extension (so the Flash file can be viewed in a HTML web page), and another with the extension swf, which is a none editable version of your movie designed to be displayed in a HTML document. (Shown below)
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Both files have to be uploaded for the movie to work.

4) Double click the HTML document and now you can watch your bouncing ball through the Internet Browser.

Although you can now see your movie your page has no buttons/hyperlinks so that it can link to your web site.  To add these complete the instructions on the following page.

Exercise 6: Linking your flash intro to your web site
In the previous exercise you published your flash movie of the bouncing ball to a HTML document.  Now by using HTML code we are going to link the page to your web site.

1) Using cut and paste, move the two files into a folder that contains another HTM or HTML document.

2) Double click ex4.htm to view your movie

3) Click view source (or open in Notepad)

4) Insert the following immediately above the </BODY> tag;

<CENTER> <A HREF="index.htm">Enter Site</A> </CENTER>

Note: Once inserted this code with add a hyperlink to the bottom of your page to link to the index page of your website. This code will only work if you have a page called index.htm, or replace this filename with the one you have used in your site. Two rules apply here, after the HREF tag the file name and extension have to be the same as one of the files/pages used in your site.  The second rule is that file containing the Flash movie (the .swf file) has to be in the same folder as the html files.

5) Click file save.

6) Refresh your Flash movie in the Internet browser and you will now have a hyperlink available at the bottom of the page that can take you to the main page of your web site.

Congratulations, you have made your first intro screen to your site!

Task 6:  Orient to Path

Try this variation of Task 4 if you have time.  You can make a long object turn to follow the path end-first, for example for an arrow or a plane, by using the Orient to Path option.


1)  Repeat the bouncing ball procedure, using a plane shape which you can draw with the oval tool, and a double loop for the guide line.  Leave a gap between the beginning and end of the line.

2)  At Frame 1 of the Plane layer, click Orient to Path in the Property Box.

3)  Use the Free Tranform Tool to rotate the plane at its start and finishing points.  Make sure the centre point of the plane is exactly on each end of the guide line.

The plane should follow the path, nose first all the way.

_ _ _ _ _  

If you wish to study Flash in more detail try and obtain a trial version of the software from (www.macromedia.com) and purchase an introductory book such as:

Penfold, R A (2002)  Using Flash 8 Babani Computer Books  

ISBN 0-85934-527-0

There are books on Flash and Flash Action Script in the Library at JWC and in Derby Central City Library.

Flash has a standard interface with menus along the top of the screen





To run an animation Flash has a timeline





Flash has some standard tools like Paint and other drawing packages, like to ability to insert text





All the work carried out in Flash in undertaken on the white area in the centre of the interface





Flash 8 has an instant help feature were you can obtain answers to commonly asked questions





More complex web components such as buttons can be inserted using the components menu on the right





Note: when using Flash you do not have the opportunity to view the code associated with the page, and the preview feature is actually called play movie
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Taken from the properties panel at the bottom of your page





The Slow layer





The Circle layer





The newly pasted circle





The original circle from the circle layer (this one moves from left to right)











Open Flash 8 from the Desktop icon NOT the Start Menu.





Name:	 				





Open Flash 8 from the Desktop icon NOT the Start Menu.





Open Flash 8 from the Desktop icon NOT the Start Menu.
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